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1 Introduction 

This reference manual explains the different buttons, menu items and windows of CreaToon®. Please 
refer to the tutorials for a how-to explanation of the different steps to create an animation. 

CreaToon® contains a toolbar which is always visible and several windows which can be individually 
opened or closed. In this reference manual, we will first look at the toolbar and then each of the 
windows will be examined in more detail. 

This manual applies to CreaToon release 1.2 (build 1.2.3.3). Check the CreaToon website 
(http://www.creatoon.com) for updates. 

Note: if you’re viewing this manual on-line, it’s best to zoom the Acrobat Reader to 134% 
or 192% magnification (Windows) or 100% (Mac), in order to obtain the best image 
quality.  See http://www.adobe.com/support/techdocs/991a.htm for more information. 

2 Toolbar 

 
 

 New:  

Selecting "new" will create an empty project.  Note that CreaToon® can have only one project 
open at any time. 

 Open:  

Opens a project file that was already saved.  Note: CreaToon® saves project files in text files with 
CTN extension. 

 Save:  

Saves the current project. If the project was not saved before, CreaToon® will suggest a name and 
a directory that you can alter if necessary. 

 

Other file commands are available under the file menu: 

Import & Export: 

You can export a selected object with all its children to a .cts file (CreaToon® sub scene 
file). Note: all resources will be exported too. 

When importing a .cts file the default parent needs to be set to a valid parent type for the 
object you will import. The object will be imported with all its children as well as all the 
resources. 

Revert: 

Revert will load the last saved version of the current scene.  
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Window buttons: 

All the buttons hereafter stand for the different windows that can either be shown or hidden:  

 Project window 

 History window 

 Tool window  

 Animation window  

 Image Resources  

 Sorting window 

 Keyframe window  

 Spline window 

 Properties window  

 Log window 

 

 

   
These buttons allow choosing the default interpolation type for new keyframes. For further 
information on the keyframe interpolation types, please see the explanation of the keyframe 
window (chapter 8). 

 

 

    
These buttons are used to constrain manipulations using any of the animation tools.   

X, Y and Z stand for the different dimensions of the 3D world of CreaToon®. 

- X is the horizontal direction (positive values to the right).   

- Y is the vertical direction (positive values in the upward direction). 

- Z is the depth direction (positive values are closer to the viewer). 

By depressing one or more of these three buttons, one can limit manipulations over one axis or a 
combination of axes.   Note that every tool (e.g. translation, rotation, scale) has its own set of axis-
restrictions. 

For more information on restricting manipulations, see the “Tools” window in Chapter 5. 

 

 

 
These buttons are related to tools like grids, guidelines, center lines, safety lines and rulers. 

 Toggle a ruler on or off, as a visual aid for positioning items. 

 Toggle grid lines on or off, at a distance specified in the grid settings, activated by  (see 
the last item in this list). 

 Toggle safety lines on or off. These are especially important if you are working for television: 
part of the outside of the image will be lost in the process of broadcasting.  The safety distance will 
help you to keep within safe borders so that e.g. subtitles will not be lost on a TV-screen. The 
distance (shown in the properties window when the grid item is active in the project window) is 
measured in percentage of the scene window. 

 Toggle guidelines on or off. These can be positioned anywhere in the window to help in 
aligning objects relative to each other. When turned ‘On’, guides are created with the ruler tool (in 
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the Tools window): right-clicking on one of the 
rulers (top or left) will create a guideline on that 
position. Guidelines are moved by dragging with the 
left mouse button down. Right-clicking again on the 
guide handle in the ruler deletes a guideline. 

 Toggle center lines on or off. Center lines 
indicate the center of the scene window. 

 Open the grid settings dialog box, shown on the 
right. Note that the default colors for the different 
lines use an alpha value of 127, which means that 
they are 50% transparent. Also note that the grid is 
shown as an item in the project tree (see section 3.8 
on page 12): so, if other objects are drawn on top of 
the grid, some of the lines might not be visible. 
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3  Project window 

 
 

The project window shows the hierarchical structure of the items in your active project. In this window, 
that hierarchy is created and organized. 

An important item in the project tree is the default parent: at all times, one of the items in the project 
tree is the default parent. One can change the default parent by right-clicking on the new default parent 
and choosing “Set as default parent” from the context menu. The exact function of the default parent 
will become clear in the following explanation of how items can be added to the project. 

Adding items can be done in several ways: 

�� •     Drag-and-drop onto the scene window. You do this by left-clicking on an image thumbnail in 
the image resources window, holding down the (left) mouse button, and dragging the image 
into the scene window. There are several options available, depending on whether or not the 
CTRL-key is pressed and on the position where the image is dropped: 

o CTRL + dropping on an object adds the image as a new animation cell, as a child of 
the object on which it is dropped 

o Dropping on an object without the CTRL-key, changes the texture property of that 
object 

o CTRL + dropping on empty space adds the image as a new animation cell, as a child 
of the default parent object 

o Dropping on empty space without the CTRL-key is a fast way to change the scene 
background: it adds a new image layer at the back of the scene with the dropped 
image as texture property. 

 •    Similar drag-and-drop operations can be done on the project tree (but note that dropping on 
empty space makes no sense in the project tree, because you can always indicate exactly 
where you want the new item to appear in the tree): 
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o CTRL + dropping on an object adds the image as a new animation cell, as a child of 
the object on which it is dropped 

o Dropping on an object without the CTRL-key, changes the texture property of that 
object 

o CTRL + dropping on the root item is again a fast way to change the scene 
background: it adds a new image layer at the back of the scene with the dropped 
image as texture property. 

•     Objects can also be added by clicking the  button and choosing the appropriate item type. 
The new item will be added to the default parent. 

•     Finally, an item can be created by right-clicking on an item to which you want to add the new 
item, choosing “Add” and selecting the correct type for the new item. 

When adding an animation cell using one of the last two methods, the “Configure Animation Cell” 
dialog appears: 

 
A bitmap can be specified, either by clicking on the arrow and choosing one from the list of existing 
image resources, or by pressing the “+” button and loading a new image. This new image will then be 
added to the image resources window. 

A selected item can be deleted by pressing the  button, the “Delete” key or choosing the “Delete” 
option of the context menu that appears when right-clicking on the item. 

Each time a new item is added to the project tree, CreaToon generates a default name, which can be 
changed if needed. 

Items are drawn in the order given by the project tree. When the order needs to be changed, items are 
dragged within the tree. (Important note: make sure you move the mouse into the white space at the 
right of the tree to be able to drop an item; you see the divider lines appear where you can safely drop 
the item). 

Listed below are all the possible items at your disposal to create your scene. 

 Root  Gradient 

 Animation cell  Grid 

 Camera  Image layer 

 Dummy  Text  

 Layer  Group 

 

Before going into detail on these items, let us first explain briefly and in general the idea behind layers. 

Consider a scene consisting of three layers (A, B and C, which are ordered as such in the project tree). 
When rendering the scene, first all items in layer A are rendered using a depth-buffer (Z-buffer). This 
results in a bitmap, which will act as ‘background image’ for the next layers. Then layer B is 
processed: all items in layer B are rendered again in an empty Z-buffer, which results in a new image, 
which is put on top of the already existing background image, using the blending mode that is chosen 
as property for layer B (see also paragraph 3.5 below). Then layer C is processed in the same way, 
resulting in the final rendered image. 

Besides defining the rendering order of the scene, the project tree also specifies parentising (which we 
already briefly encountered at the beginning of the project window, where we talked about adding 
items “as a child” of other items). Items that are placed below (and more to the right of) another item in 
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the project tree are “children” of the higher item. E.g. in the Ivar demo scene (of which the project 
window image at the beginning of this chapter shows part of the project tree), several items are 
parentised to other items: the limbs are parentised to the body and each of the animation cells is 
parentised to a dummy. In this case, animation cells are parentised to dummies, in order to change the 
rotation point of the cell (the default rotation point is the center of the cell). 

There is one more tool available in the project window: the copy node tool . This tool permits you 
to create multiple copies of a certain item in the scene (as you can see in the picture below). This is a 
very powerful tool, as it copies also all children of the item copied. E.g., you can create multiple Ivar 
characters in one scene, simply by creating one character in one layer (or group, see later) and creating 
multiple copies of that character, using the copy node tool. In the dialog box, you can identify which 
object to copy, to which parent, and how many copies should be created. The new copies are 
independent of the original: if you change the original object after creating the copies, the copies will 
not be affected by those changes. 

 

3.1  Root 

The overall parent of a project is the Root item. Here you define the camera to be used for the final 
animation, the aspect ratio and the background color of the scene. 

Properties: (see properties window when this item is selected) 

Render Camera: This is the camera that is used for the scene window. It is possible to switch to 
another camera at any frame, so that camera cuts can be defined very easily. 

Aspect ratio: Choose one of the settings (options are: 768/576, 720/576, 16/9, 15/9, 2/1, 1/1 and 
468/60) to define the final format of your animation. The aspect ratio can be altered at any point in 
the development of your animation.  Of course, there can only be one aspect ratio throughout the 
whole (final) animation. 

Background color: This color will be put behind the animated items. Its default is black. This 
property cannot be animated. (Note: for animating the background color, see section 3.6 below). 
To change the color, either activate the color picker by clicking on the small color square, or enter 
the R, G and B values in the property boxes. 

3.2  Animation cell 

An animation cell is a bitmap-item that is filled with any of the bitmaps loaded into the image resource 
window (see chapter 7 on page 17). These 'pieces of drawing' form the scene and characters (just like 
in traditional cut-out animation). 
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Properties: (see properties window when this item is selected) 

Generic properties: 

Translate, Rotate, Scale: Define position, rotation angle and scale factor of the animation cell here 
or by using the mouse. For more information about performing these basic transformations, see the 
discussion of the Tools Window (chapter 5 on page 15). 

Appearance: 

Dimensions: By default, this property shows the size of the original bitmap as it is loaded from 
disk. When no bitmap is associated yet with the Animation cell, the default size is 200 by 200 
(white) pixels. Changing this property has the same effect as performing a scale operation. 

Color: This color property will be multiplied with the texture color. This permits you to apply a 
“color filter” onto the texture, without changing the original texture file itself. The default value of 
this property is pure white (255,255,255): this leaves the original texture unchanged. 

Texture: The default bitmap of an animation cell is ‘empty’, i.e. a white square of 200x200 pixels. 
Click the combo-box and select one of the bitmaps in the list (showing the bitmaps that you loaded 
into the image resource menu) to assign it to the animation cell. Since this property can be 
animated, an animation cell can change its appearance during the animation. 

3.3  Camera 

Camera properties:  (see properties window when this item is selected) 

Generic properties:  

Visible: Indicates if the camera is visible as a green cone in other camera views. 

Aspect ratio: Property to set the aspect ratio of the rendered image, when the scene is viewed with 
this camera. Options are: 768/576, 720/576, 16/9, 15/9, 2/1, 1/1 and 468/60. 

Translation: Defines the position of the camera within the 3D world. Changing the Z value moves 
the camera in or out. 

Roll: Sets the rotation along the viewing axis of the camera. 

FOV: Defines the (vertical) field-of-view of the camera, in degrees. E.g., the default value of 40 
defines a camera with a 40-degree view. Making this property smaller narrows the field of view 
and hence acts like a real zoom-in without moving the camera. Similarly, a larger field of view 
yields a zoom-out (ultimately: a fish-eye view), without moving the camera. 

Mode: You can choose between perspective and orthographic mode. 

3.4  Dummy 

A dummy is an empty or an invisible item, mainly applied to create a hierarchy when pivot points are 
needed other than the center of an item (e.g. an animation cell). Create a dummy, attach the animation 
cell to it as a child and position it so that the center of the dummy can function as the pivot point of the 
bitmap. 

Dummy properties: (see properties window when this item is selected) 

Generic properties: 

Translate, Rotate, Scale: Define position, rotation angle and scale factor of the dummy here or by 
using the shortcuts and mouse buttons. 

Visible: When on, the dummy is visible as a set of three axes (red=X, green=Y and blue=Z). On 
most occasions, a dummy is made invisible as soon as its position and orientation is set correctly 
for the animation. 
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3.5  Layer 

A layer is a part of the scene that can contain any set of items (e.g. dummies, animation cells). It can be 
made visible or invisible as a whole, by toggling the visibility checkbox . (Note: if a non-layer object 
is selected, the layer containing the selected object is the one that will be made visible or invisible). 

Layer sorting properties: (see sorting window when this item is selected): 

Layer properties: (These properties are common to all layer types – they are also used by groups) 

In general, the items in a CreaToon® scene will be blend together in the rendering process. This 
means that all the bitmaps in a layer will be merged based on one of the blending methods 
explained below, with the already existing background image. When blending is not used, 
CreaToon® switches to threshold mode. Remember the principle of layers: each processed layer 
results in a new background image on top of which the next layers will be rendered (see the 
general introduction on layers, at the beginning of this chapter). 

Blending: This toggles between different blending modes. Possible modes are (see the technical 
note below for more information): 

Off: No blending is applied. Outlines remain jagged since alpha threshold is applied (see 
below). Allows faster playback, but in general, blending should be turned on for the final 
rendering. In this case, the upper image’s alpha value is compared to the threshold value: only 
when the upper image’s alpha value is larger than the threshold in a certain pixel, the upper 
image’s pixel is rendered. (Note: using a threshold of zero in fact turns off alpha threshold: the 
upper image is rendered completely opaque.) 

Normal: Alpha blending is applied, which yields a smoothing and transparency effect. 
Outlines are now smooth (no longer jagged), as the alpha value is used to define the level of 
transparency for each pixel. ‘Mix’ is the most applied blending mode for final rendered 
images. The next five modes allow effects that are more creative. 

Multiply: Multiplicative blending is applied, which yields a color filtering effect. 

Add: Additive blending is applied, which lightens the lower images. 

Subtract: Subtractive blending is applied, which darkens the lower images.  

Minimum: The minimum color value of new foreground image and the existing background 
image is taken as new color.  

Subtract: The maximum color value of new foreground image and the existing background 
image is taken as new color.  

Technical note: The alpha-key is an extra (invisible) channel next to the Red, Green and Blue 
values of each pixel in a 32-bits bitmap. It is used to make certain pixels show (opaque) or not 
(transparent) like a mask. Just like the R, G, B channels this Alpha channel also has a range of 
256 values to make things more or less transparent. In CreaToon, the alpha-value 255 is 
opaque, while alpha value zero is transparent. 
Not all bitmap file formats support this fourth channel; TIFF, PICT and TGA do. To create 
bitmaps with a key, and to edit this key directly, you need to use the higher end paint programs 
and save the bitmap at 32-bits. Windows Paint only allows you to save 24-bit which is R, G, 
and B only. 
The exact mathematical expression for ‘Mix blending’ is: resulting color = new color * new 
alpha + background color * (1 – new alpha). 
For multiplicative blending: resulting color = new color * background color. 
For subtractive blending: resulting color = new color - background color. 
For additive blending: resulting color = new color + background color. 
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Manual Sort: When manual sort is on, all items in the layer are put into a list in the sorting 
window, where they can be sorted manually (the one at the top of the list is drawn first). This 
allows you to fine-tune the relative depth of all items in a layer, without having to give them all 
different Z-values. A good example of when to use this option, is when you create a character that 
should appear flat, but where you need to be able to say that one leg is behind the body and the 
other is in front of the body. Look at the Ivar demo scene for an example of this manual sort 
option. 

3.6  Gradient layer 

A gradient layer is a layer that contains a gradually changing color (see next figure for an example). 
The number of colors in the gradient can be configured. The gradient is rendered in the background of 
this layer and its colors can be animated. 

Very often a gradient layer is used as a background, e.g. 
to simulate air, land and a horizon in between. However, 
many other effects could be obtained by putting a 
gradient layer in front of other layers and applying 
different blending styles (see the discussion of Layers in 
section 3.5 on page 9 for more details on blending). 

E.g. using the "Mul" (multiply) blending, shadows can be 
created, using Add blending generates highlights – fog 
can be generated by changing the alpha value over the 
gradient. All these effects can be animated.  Mini-
tutorials explaining these kinds of effects can be found 
on the CreaToon® website. 

There are no specific properties for a gradient layer, so 
we refer again to the discussion of the Layer object 
(section 3.5 on page 9) for the sorting properties. 

By default, a gradient is created with two separators: one at the top of the image and one at the bottom. 
In the above example, you see two handles indicating the top and bottom colors of the gradient. 
Changing any of these colors can be accomplished by clicking within the handle triangle, which 
activates a color picker, as shown in the next figure. 
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Adding separators is done by activating the ‘Separator’ tool in the Tools window, when the 
gradient is selected and right-clicking in the scene window at the position where the separator 
should be created (see following picture). 

 
A two-color separator can be used, e.g., to make a horizon line. Changing the colors of this middle 
separator can be done similarly: the triangle pointing upward indicates the color above the line, 
while the other triangle indicates the color below the separator line. Both can be changed 
simultaneously by clicking on the parallelogram between the two triangles. 

A separator line can be moved by dragging the handle and it can be removed by right-clicking on 
its handle. For more information about manipulating separators, see the discussion of the Tools 
window (chapter 5 on page 15). 

Important note: since gradient layers are merely items in the scene tree, it is possible that other 
items are on top of the gradient layer.  This means that sometimes the gradient handles are hidden 
by other scene elements; in that case, it is best to turn off the visibility of those other items while 
editing the properties of the gradient. 

3.7  Image layer 

An image layer is like a normal layer, but contains a Texture property, which allows you to indicate a 
texture bitmap that will be stretched fully to the size of the viewport, and that will be put at the back of 
this layer. Besides this, it behaves like a normal layer (and has the same sorting properties as a normal 
layer). 

Image layer properties: (see properties window when this item is selected) 

Layer properties: see section 3.5 (discussion of the Layer object) 

Appearance:   

Color: This is a color that will be multiplied with the Texture’s color, yielding a filter effect on the 
texture of the image layer. This is similar to the ‘Color’ property of an animation cell. 

Texture: An image layer can contain a bitmap as background, which will be stretched to the full 
viewport size. This is mainly used to set the background of the scene, but can also be used to 
create effects using alpha blending. 

Large: This option permits to circumvent the maximum texture size (1024x1024 for software 
rendering, 512x512 for most OpenGL accelerator cards, etc.) by letting CreaToon® cut internally 
the image in smaller pieces and rendering the pieces using multiple quads. We advise you to use 
this option only when you really need large textures (e.g. large backgrounds over which the 
camera needs to travel), because of the speed penalty of this approach.  
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3.8  Grid 

A grid is an item that is always present in a project. It cannot be deleted or created. It will never appear 
in a final rendering of an animation, because its lines are only used as positioning aids. For a discussion 
of the different options available in a grid item, we refer to the toolbar discussion, where the grid-
related buttons are explained. 

Grid properties: (see properties window when this item is selected) 

Most of these properties can be set interactively (e.g. by using the grid settings button ). Other 
settings can only be changed using the properties window: 

Safety distance: as mentioned in the Toolbar discussion (chapter 2 on page 2), safety lines can be 
displayed to make sure you are not showing any crucial animation outside the visible area of a 
television monitor. The safety distance is given in percentages of the horizontal and vertical resolution 
(10% in both directions, by default). 

3.9  Text 

A text object allows the use of a line of 2D text in a “truetype” font as a CreaToon® animation. 

Text properties: (see properties window when this item is selected) 

Generic properties: 

Translate, Rotate, Scale: Define position, rotation angle and scale factor of the text object here or 
by using the mouse. For more information about performing these basic transformations, see the 
discussion of the Tools Window (chapter 5 on page15). 

Color: Set the color of the text. The default value of this property is pure white (255,255,255). 

Text: This is where you define the actual text 

Align: Set the alignment of the text with respect to the origin of its local coordinate system (left, 
center or right). 

 

This object has also an extra “configure” tool, which will display the following dialog where you can 
specify the font for the text. 
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3.10  Group 

A group provides a way to take several items together and to manipulate them as one item. A group has 
several properties, some shared with “physical” items like animation cells (translation, rotation, scale) 
and others with layers (sorting properties). Hence, we refer to these other items for an explanation of 
the properties. 

One special property is the “visible” property: since a group as such is never visible (it’s just a means 
of grouping other elements), it is displayed as a set of axes, just like a dummy. The “visible” property 
in the case of groups refers to the visibility of these axes (and not of the items contained in the group). 
If you want to toggle the visibility of the items in a group, use the eye icon in the sorting window. 

The main reason for using groups is to put several items at the same depth and sorting them manually 
(like you can do with a layer). The main difference with a layer is that a layer does not have its own 
transformations (translation, rotation, scale). A good example where to use a group is for animation of 
characters built from several composing elements. It’s quite difficult to put all these elements at the 
correct relative depth to make sure that the back elements always remain at the back, while front 
elements stay at front (in CreaToon 1.0, it was necessary to manually adjust the Z value of different 
elements, but not too much, if you didn’t want to introduce too much perspective). You can then sort 
all items in this group manually (by turning “Manual sort” on) and manipulate the group as a whole by 
manipulating the group item only. 
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4  Sorting window 

 
Most of the items in this window are already explained in the discussion of layers (in section 3.5 on 
page 9). In this window, several properties of layers and groups can be inspected or changed. 

The visibility icon provides a way to toggle the visibility of a whole layer or group: if the “eye” icon is 
shown, the layer/group is visible. Note that the name label of this checkbox shows the next higher layer 
or group in the project tree when another object (e.g. an animation cell or a dummy) is the currently 
selected item in the project window. 

Blending and manual sorting are explained in the discussion of layers (see section 3.5 on page 9). 
When you turn on manual sorting, a list of items contained in the current layer or group is shown in the 
sorting window. In this window, you can change the drawing order of these items. In the above 
example (taken from the sample scene Ivar), LegBack will be drawn first, then Body, etc. This feature 
is especially useful when creating characters consisting of different elements, which should be at the 
same depth in the scene: in this case, it’s best to create a group containing all elements, and sorting 
these elements manually instead of giving each element a different Z-value. 
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5  Tools window 

 

This menu shows the tools that are available for changing the active item 
on the active frame.  Different types of items have different sets of tools 
sometimes. The tool menu displays the typical set of the active item.  

Note that many of these tools make use of the settings of the ,  and  
toolbar buttons to constrain the movement to certain axes.  

Translate: When the translate tool is active, the currently selected object 
can be translated. Dragging with the left mouse button moves in the X, Y 
plane (horizontally and vertically), whereas dragging with the right 
mouse button down moves in the depth direction (Z). In the latter case, moving the mouse up moves 
the object forward (deeper – larger Z); moving down moves the object closer to the viewer (less deep – 
smaller Z). 

Rotate: Similarly, this tool rotates the selected object. When using the left mouse button, rotation 
around the X- and Y-axes are performed; the right mouse button yields rotation around the Z-axis. 
Remark: when rotating an animation cell around the Z-axis (the most used rotation). 

Scale: The scale tool sizes the selected object. Again, using the left mouse button, scaling in the X and 
Y direction is performed. (Note that for the set of objects, currently supported in CreaToon® , a Z scale 
is not useful.) 

Holding down the Shift key while dragging with the left mouse-button down will keep the original 
aspect ratio, without distortion in either of the two directions. 

Separator: (for gradient-items ONLY)  

This tool will only appear when a gradient-item is selected. 

To add a separator: Right-click in the scene and on the position desired. 

Delete a separator: Right-click on a separator-line in the scene.  A gradient-tool cannot have less than 
two colors.   To generate a uniform color, choose the same color for both separators. 

To move a separator: left-click on it and hold mouse-button down while dragging the separator across 
the scene. 

A separator can have either one color (both sides of separator are the same color) or two colors (both 
sides may be different colors). This is useful e.g. to create horizon-lines etc.  

The lines shown as separators here are only shown when the gradient is active, they are not rendered 
nor will they be shown when the gradient is not selected. 

Separators can be animated by color and position. 

All animation changes performed on the separators are seen in the keyframe window when the 
gradient-item is selected. 

Ruler: (for grid layers only, when the Guide lines are turned On)  

Create a new guideline by right-clicking on the ruler (top or left) when this tool is activated. 

Right-click on a created guideline’s handle again to remove it. 

Move guidelines by dragging their handle in the ruler, while pressing the left mouse-button 

Roll: (for cameras only) 

When a camera is selected, the roll tool allows you to change the camera roll (its rotation along its 
viewing direction). Drag the mouse with the left button down to change the roll value. 
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6  Animation Controls window 

 
The buttons on the animation window are similar to the buttons of any regular video player. 

 Jumps back to the first frame of the animation. 

 Stops the playing of the animation AND jumps to the first frame. 

 Pauses animation at current frame. 

 Plays the animation starting from the current frame. 

 Jumps to the last frame of the animation. 

 Defines whether the animation is played once and then stopped or played in a  
continuous cycle. 

 Play a specific selection.

  Shows the current frame number. 

The slider bar shows the relative time of the current frame within the whole animation.  

Note: One can change the current frame by dragging the slider or by changing the current frame 
number in the number box. 
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7  Image Resources window 

 
This window shows all the bitmaps you loaded to use in the current project. Refer back to the general 
explanation of the project window, to see how you can use drag-and-drop functionality to easily create 
your scene.  

 

 Add another bitmap to the image resource window. Note: you can also drag-and-drop 
images from anywhere on your desktop into the image resources window (instead of 
explicitly adding them with this ‘+’ button). 

 Reload/update the selected bitmap that might have been altered while CreaToon® was 
running, e.g. when images are altered within a painting program while they are being used 
within CreaToon®. 

 Remove the selected bitmap from the project. Note: this is only possible if the image file 
is not in use (e.g. as texture property of an animation cell or image layer). 

 Toggles between displaying image resources as thumbnails or as a list of filenames. 

 Cleanup will remove all unused images. Note: This action cannot be undone and the 
history will be cleared. 

 

Right-clicking on an image in the image resources window activates a pop-up menu with the following 
choices: 

Add: allows the user to add new image resources. This is the same as pressing the “+” button. 

Reload: reloads the selected image from disk. If it is edited in another program, the changes will be 
reflected in CreaToon. 

Remove: is the equivalent of the “-“ button and removes the image from the resources list. 

Alpha: permits to set the alpha value of the pixels in a bitmap, based on one of the available two 
options: 

From color means that a certain color can be chosen (using a color picker), this will act as the 
“transparent color” for the selected bitmap. 
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From file permits you to specify a file, which will be converted to grayscale: these gray values 
will act as alpha values for the originally selected bitmap. 

Edit: this option allows you to launch an external image-editing program to modify the selected 
bitmap. The external program is configured in the File->Configuration menu option. If there is no such 
bitmap editing program configured yet, CreaToon prompts the user to specify one, when he first 
chooses “Edit”. 
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8  Keyframe editor 

 
The keyframe window permits to see the keyframes defined within your animation. For the active item, 
all properties that may be animated (also called ‘channels’) are shown in the keyframe editor. 

There are three keyframe interpolation types, as explained below. 

Selection of frames within the keyframe editor is done as follows: 

•     Click for one frame in one channel. 

•     Click + drag, or click on one frame and shift-click on other frame for multiple frames. 

•     Click on a channel name (e.g. “Translation”) to select the entire channel. 

•     Click + drag in the ruler to select a range of frames on all channels. 

•     Click on the object name to select all frames of all channels of this object. 

•     Click above the object name to select all frames of all channels of all objects in the scene. 

These are the buttons available in the Keyframe editor: 

 Put a key at the active frame, using the default interpolation type indicated in the 
toolbar (see Toolbar in chapter 2 on page 2). 

 Delete the key on the selected frame. 

 CreaToon® will do NO interpolation between keyframes of this type.  The value of a 
keyframe of this type will be maintained until the next keyframe (e.g. for stop motion 
effects). 

 CreaToon® will make animation in straight lines and equal timings between 
keyframes of this type. This is called “Linear interpolation”. 

 CreaToon® will make a ‘smooth’ animation between the keyframes of this type. This 
is called “Spline interpolation”. 

 Jump to the next keyframe. If only one channel is active, CreaToon® jumps to the 
next keyframe within that channel. If multiple channels are selected, CreaToon® 
jumps to the next keyframe in any of the selected channels. 

 Jump to the previous keyframe. If only one channel is active, CreaToon® jumps to 
the previous keyframe within that channel. If multiple channels are selected, 
CreaToon® jumps to the previous keyframe in any of the selected channels. 
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 When you need to lengthen an animation by inserting frames before a certain frame, 
follow this procedure: 

•    Click + drag the desired number of extra frames, starting from the frame 
where the extra frames have to be inserted. E.g. if you want to insert 10 
frames before frame 24, click on frame 24 and drag 10 frames to the right 
(note that the tool tip shows the number of frames selected). 

•      Press the  button. 

•       All frames from the first selected frame onwards (frame 24 in the above 
example) will be automatically shifted to the right (with 10 frames in the 
example). 

Note: depending on the way frames are selected (see above), the insertion will be 
done on either one channel, or all selected channels. 

 Similarly to the insertion of new frames, this button deletes the selected range of 
frames (either within one channel, or within multiple channels, depending on the 
selection). All frames after the deleted sequence will be shifted forward in time. 

 Scales the selected frames in time. One can either specify a new number of frames 
for the scaled animation sequence, or give a percentage with which the scaling has to 
be performed: 

 This button activates the copy-frames tool. This powerful tool is similar to the copy-
nodes tool in the Project Window. It permits to copy (a range of) keyframes to 
another point in time, and even to another object. The following dialog opens when 
using this tool: 
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In this dialog, you can choose the source of the copy operation (object, channel(s) 
and frame range) and its destination (same choices). In addition, a number of copies 
can be given to repeat copying the source, putting one copy after the other in time. 

 This button activates the move-frames tool. It permits to copy (a range of) keyframes 
to another point in time. The following dialog opens when using this tool: 

 
In this dialog, you can choose the source of the copy operation (object, channel(s) 
and frame range) and where these frames should be moved. One can choose to 
specify the distance in number of frames (e.g., a distance of –20 moves the selected 
keyframe(s) 20 frames back in time) or to give the absolute frame position. 

 Moves active frame one frame back in time. 

 Active frame: One can alter the active frame by inserting a new frame number here. 

 Moves the active frame one frame forward in time. 

 Total number of frames: One can alter the total number of frames for the entire 
animation by typing a new frame number here. 

 

The light yellow vertical bar in the keyframe editor indicates the current frame. At the top left of the 
window, the name of the selected item is displayed. 

 

There is also a popup menu when you right click on a keyframe. This menu contains several of the 
tools mentioned above and it contains also a command, which allows you to edit the tension, continuity 
and bias when the keyframe type is “spline interpolation”. 
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9  Spline editor 

 
In the spline editor you can see and edit the keyframes of a specific channel of the active item. Most 
of the options you have in the Keyframe editor are also available in this window (See chapter 8 for an 
explanation on the common buttons.). 

 

These extra buttons are not available in the Keyframe editor: 

 Edit the keyframes (represented as yellow dots) by selecting them and dragging them 
around. There are two methods to edit a keyframe: 

 -You can select a keyframe by left clicking on the frame but not on the keyframe 
itself. This will allow you to move the keyframe horizontally to another frame. 

 -You can select the keyframe by left clicking on the yellow dot. When you do this, a 
horizontal line will appear. This means that you can change the value at the keyframe 
by moving it vertically. (When changing a keyframe, you can see its value in the 
Property window.) 

 This is the pan tool. When you left click and drag, you can change your view upon 
the channel by panning up and down, and from right to left. 

 With the zoom tool you can zoom in by left clicking in the window or by dragging a 
selection rectangle around the area of interest. You can zoom out when you hold 
down the ctrl key and left click. 

 Fit the view on the channel so that the entire length of the animation is visible. 

 Fit the view on the channel so that the minimum and maximum values are visible. 

 

 Select the channel of the active object you want to see and/or edit. 

 

There is also a popup menu when you right click on a keyframe. This menu contains a command, 
which allows you to edit the tension, continuity and bias when the keyframe type is “spline 
interpolation”. 
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10  Properties window 

 
This is an example of what the “Properties” window can look like. 

Because the number and type of properties that are shown here depend on the type of the selected item, 
all the specific properties were explained with the type of items in the Project window discussion. 

Entries with a ‘+’ sign can be expanded to see/edit its components. Entries with a ‘-‘ sign are expanded, 
and will be collapsed again by clicking on them. 

A key symbol in front of a property indicates that this property can be animated. A golden key 
symbol means that there is a key frame for this property at the currently selected frame. A silver key
means that there is no key frame for this property at the currently selected frame. 

Hint: if you need fine control over the numerical values for one of the properties, an easy 
way to repeatedly type different values is the following: click on the property name (e.g. the 
“X” of Translation) and type a new value using the keyboard. Without pressing the 
“Enter” key, click again on the property name and retype. You can repeat this as many 
times as you need to fine-tune this property. 

11  History window 

 
CreaToon® has a multiple undo function. You can undo up to 40 changes you made to your animation. 
All the steps are shown in the history window with a short description for identification. When the 
project is saved, the undo-list is lost.  When loading a project from disk, CreaToon® starts with an 
empty history. 

To undo an action, simply choose Edit->Undo from the main menu, or use one of the shortcuts Ctrl-Z 
or Alt-Backspace. To redo an undone action, choose Edit->Redo from the main menu or use the Ctrl-Y 
shortcut. These changes will be reflected in the History window. 
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12  Log window 

 
This window is used for system logging purposes. E.g. when loading an animation file with references 
to image files that don’t exist (perhaps because they were renamed or moved to another directory), a 
dialog box appears to inform you of that fact, and a full list of missing files is written to the log 
window. 

13 Rendering 

When rendering an animation sequence to disk (by choosing “Render” from the main menu), the 
following dialog window is shown: 

The available options are: 

Render module: In the current version, only 
“Software Render Plugin” is available as 
option. 

Range: either all frames or a specified 
range of frames will be rendered to disk. 

Output: File parameters are set in this pane: 

Prefix is the name that will be used for the 
output file(s). When rendering to separate 
image files (see below), a 4-digit number is 
appended to this prefix for each of the 
frames. 

Folder is the directory where the output 
file(s) will be saved. 

Type lets you choose between rendering to 
separate image files for each frame, or to 
one movie file. Depending on this setting, 
different options are available in the next 
item. 

Plugin gives you the choice between 
different image plugins to be used for 
saving the rendering results. When the Type 
field is “Image”, the options are Targa, 
JPEG, BMP and PNG. When rendering a 
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movie file, AVI is chosen as output format. 

Hint: when rendering an animation to separate images, in order to single-frame them using a 
recording program, make sure that the file names conform to the requirements of the 
recording application.  E.g. when using a Perception card and its recording software, file 
names have to be limited to 8.3 characters (8 before the dot, 3 behind the dot): since 
CreaToon adds 4 digits to the prefix, don’t use a prefix of more than 4 characters. 

Field rendering: When rendering for video, it is mostly necessary to apply field rendering (see 
technical note below for details). Field rendering is activated by checking the “Enable” option. The 
order of the field rendering (first even, then odd or vice versa) can be toggled with the “Reverse fields” 
option. Note: field rendering takes more time than the normal frame rendering, so you are advised to 
only use field rendering when the final animation has to be output to PAL or NTSC video and you 
don’t want a strobing effect. 

 

When pressing the “OK” button, the Rendering Configuration 
window pops up:  

 

Size specifies the output bitmap size in pixels. 

Antialiasing specifies whether or not jaggy edges have 
to be removed. For most animations, this option will be 
activated for the final rendering. 

 

 

 

Technical note: PAL or NTSC monitors display frames in interlaced mode, in a certain field 
order: all even-numbered lines are displayed in one field, all odd-numbered frames in the 
other field. To compensate for the time difference between the first and the second field (which 
together make up one final frame), the field rendering option permits to generate each field 
with half a frame difference in time. This makes movement much smoother in the final
rendering. Keep in mind that a field-rendered image contains a combination of two images; 
therefore, it is hard to view it as a still image. 
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14 List of shortcuts 

Several shortcuts have been defined in CreaToon® to rapidly access basic functions from the keyboard. 
Here is a list of shortcuts: 

 

Shortcut key(s) Function 

1 Project Window 

2 History Window 

3 Tools Window 

4 Animation Control Window 

5 Image Resources Window 

6 Sorting Window 

7 Keyframe Editor 

8 Properties Window 

9 Log Window 

Alt-Backspace or Ctrl-Z Undo 

Ctrl-Y Redo 

Ctrl-N New File 

Ctrl-O Open File 

Ctrl-S Save File 

Ctrl-Shift-S Save File As… 

End Last Frame 

Home First Frame 

Shift-Left Previous Frame 

Shift-Right Next Frame 

Ctrl-Left Previous Keyframe 

Ctrl-Right Next Keyframe 

Space Pause/Resume Playback 

 

The following shortcuts can only be used when scene window is active: 

Shortcut key(s) Function 

T Select translate tool 

R Select rotate tool 

S Select scale tool 

X Toggle X lock 

Y Toggle Y lock 

Z Toggle Z lock 
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15 Preferences 

CreaToon® permits to set some preferences, using the menu option File->Preferences. The following 
dialog box will appear: 
 
The available preferences are: 

Selecting objects: This preference 
sets the selection mode when the user 
clicks in the scene window: 

Left mouse click selects / Ctrl + 
left mouse click does not means 
that an object can be selected in 
the scene window by a simple 
left mouse click. If you hold 
down the CTRL-key, this 
selection is inhibited, which 
permits you to move an object 
without selecting another one in 
the same neighborhood.  

The second option yields the 
opposite behavior. 

Camera settings: There are three 
options for this checkbox: a gray 
check mark means that the visibility 
of cameras depends on the “Visible” 
property in each camera, “off” means 
that cameras are never visible and 
“on” means that all cameras are 
always visible (irrespective of their 
visibility option). 

Dummy settings: These allow you to 
specify when the dummy objects will 
be visible. 

Grid defaults: Different items of a 
grid can be on or off by default. 

Frame rate: You can choose between 
25 fps or 30 fps for previewing and 
rendering. 
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